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Introduction

Welcome to Jixxa, the first virtual jigsaw puzzle for your computer. Jixxa is brought to
you by Rhode Island Soft Systems, Inc., the makers of other fine Windows products.
This document will introduce Jixxa and detail its many features and options. Please
refer to the final pages of this document for information on ordering the retail version
of Jixxa with additional jigsaw puzzles.

Jixxa is a truly realistic jigsaw puzzle with a few improvements over conventional
puzzles. You begin a puzzle with pieces scattered randomly about the screen. Grab a
piece using the mouse and drag it around. Drop the piece next to another and see if
they lock. Once locked, the pieces become a single unit that can also be dragged!

Unlike other computer puzzles, Jixxa has real jigsaw shaped pieces that can be moved
freely. Pieces lock only with other pieces, not to some imaginary location on the
screen. Jixxa puzzles use high quality interesting images that are not limited to any
particular size.

Jixxa comes with a box so you can organize your pieces. In fact, you can even create
up to 9 boxes! Name your boxes (Edges, Green Pieces, etc.) and sort the pieces
accordingly. You can resize, move, hide and show the boxes to customize your work
area to fit your needs.

In addition to the boxes, you can also pickup pieces. When you pickup pieces, they
disappear from the screen and float around in your virtual hand! Hold on to them for a
while and perform other functions, drop one at a time or drop them all. Drop them on
the screen or drop them in a box.

Ask Jixxa for a hint or solution. Hint allows you to click on a piece to find a match.
Jixxa can also solve the puzzle for you, at an adjustable speed so you can watch it
happen and stop it at any time!

Don't worry if you can't finish the puzzle in one sitting. Jixxa allows you to save your
puzzle and load it later - right where you left off. All of your options and boxes remain
in tact!

Jixxa puzzles are available in different piece sizes as well as image sizes to satisfy the
novice, intermediate and expert puzzlers. Still not tough enough? Jixxa also has
options to rotate pieces and lock pieces that don't match! Pieces can be rotated in 4
directions. You won't know which way is up! Many pieces have similar sides - Jixxa
will lock non-matching pieces for you if you want a real challenge.



Loading a Puzzle

To load a new or a previously saved puzzle, select Load from the File menu and
follow the prompts. New and saved puzzles are stored as different file types. When
you are prompted to select a file, you can change the listed file type between new,
saved or both.

To make loading easier, Jixxa remembers the last puzzle you worked on and prompts
you with the file name already typed.

Saving a Puzzle

To save a puzzle, select Save or Save As from the File menu and follow the prompts.
If you have already saved a puzzle, the Save option will not prompt you for a new file
name. Note that file names are limited to 8 characters.

How to Use Jixxa

Jixxa 1s a realistic jigsaw puzzle. When you start a new puzzle, the pieces will be
scattered about the screen. You can click on pieces using the mouse and drag them
around the screen. You can also pickup pieces, sort them into boxes and even ask for a
hint or have the puzzle solved for you.

Jixxa is controlled primarily with combinations between the keyboard and mouse. The
cursor will change automatically to assist you in determining the various functions that
can be performed. There is also a description of each function on the status bar at the
bottom of the screen. These are the cursors you will see in Jixxa:

Hand This cursor is used to grab pieces.

Up Arrow This cursor is used to pickup pieces.

Down Arrow This cursor is used to send pieces to the bottom.

Question Mark This cursor is used to get a hint. Click on a piece to
see where it goes.

Hammer This cursor is used to nail pieces down. A piece that

is nailed down cannot be dragged. If a piece is already
nailed down, the hammer turns upside down (Claw) to
indicate that the piece can be released.

Claw This cursor is the upside down hammer. It is
used to release pieces that are nailed down.

No! This cursor indicates that a function cannot



be performed at the cursor location.
Double Arrows These cursors appear when a box can be sized or
moved.



The left mouse button is used to grab a piece. When a piece is grabbed, it will lift off
the screen slightly and a shadow will appear under it. While holding the left mouse
button, you can drag the piece around the screen by moving the mouse. When you
release the left mouse button, the piece will be dropped. If the piece is in the vicinity
of a matching piece, the two pieces will be locked. Locked pieces become a single unit
and can be dragged as a single piece.

Note: A snapping sound is played whenever two pieces lock. To hear this sound, the
Sound option on the Options menu must be checked and your system must have a
sound driver installed.

If you click the left mouse button while the cursor is not over a piece, a lasso will
appear. The lasso is used to pickup single pieces. While holding the left mouse button,
move the mouse to drag the lasso around the pieces you wish to pickup. Any pieces
that are within the boundaries of the lasso will be picked up. Note that if the lasso is
started on the screen then only pieces on the screen will be picked up, and if the lasso
started in a box then only pieces in that box will be picked up. The status bar at the
bottom of the screen will show how many pieces you are holding. Any number of
pieces can be picked up.

The Shift key in combination with the left mouse button is used to pickup individual
pieces. Simply click on the piece you wish to pickup. Whenever the Shift key is
depressed, the cursor will change to an up arrow to indicate that pieces can be picked
up. Note that if the cursor is over a box but not over a piece, the cursor will change to
a crossed arrow indicating that the box may be moved.

Note: Only single pieces can be picked up. Once two or more pieces have been
locked, they cannot be picked up.

The right mouse button is used to drop pieces. Clicking the right mouse button drops
all held pieces and scatters them randomly in the vicinity of the cursor. If you hold the
Shift key and press the right mouse button, one piece will be dropped underneath the
Cursor.

The Control key in combination with the left mouse button is used to send pieces to
the bottom (that is, push a piece underneath all other pieces). Whenever the Control
key is depressed, the cursor will change to a down arrow to indicate that pieces can be
sent to the bottom. Note that single pieces cannot be sent under assembled pieces.

The display can be scrolled by clicking on the scroll bars or by using the arrow, Page
Up, Page Down, Home and End keys. The display will also scroll automatically if the
left mouse button is held and the cursor is moved to the edges of the display.

Boxes can be resized, moved and hidden. When a box is visible, you can drag pieces
in and out of it, or pickup pieces and drop them in or out of the box. Refer the Menu



Commands section below for information on box options.
Note: Only single pieces can be in a box. Pieces cannot be assembled in a box.

You can interrupt the puzzle for a full screen view of the picture. The picture can also
be seen in a floating box top. The floating picture can be resized, moved and hidden.
The picture is always on top of everything else. Refer the Menu Commands section
below for information on picture options.



Menu Commands

File Menu

Load Puzzle. Select this option to load a puzzle. Refer to the earlier section on
Loading a Puzzle for more information.

Save Puzzle. Select this option to save a puzzle. Refer to the earlier section on Saving
a Puzzle for more information.

Save Puzzle As. Select this option to save a puzzle in a new file. Refer to the earlier
section on Saving a Puzzle for more information.

Close Puzzle. Select this option to close the current puzzle.

Exit. Select this option to exit Jixxa.

Options Menu

Fast Drag. This option speeds up the animation when dragging several locked pieces.
When dragging larger pieces with this option on, only the piece under the cursor is
shown and a rectangle shows the approximate size of the entire block. Otherwise the
entire block of pieces is animated.

Scroll Bars. This option turns the scroll bars on and off. Note that the arrow, Page Up,
Page Down, Home and End keys can be used to scroll the screen.

Status Bar. This option turns the status bar on and off. The status bar provides
information on the various functions that can be performed.

Sound. This option turns the sound on and off. A sound is heard whenever two pieces
are locked.

Music. This option turns background music on and off. A directory containing
musical MIDI files should be selected by using the "Choose Music" option described
below.

Note: The music option will only work if you have a sound card capable of playing
MIDI music files.

Choose Music. This option allows you to select a directory containing MIDI music
files (files with .MID extensions). These files can be played as background music
while playing Jixxa! Using this "Choose Music" option to select a directory. All of



the

files in the directory will be played in a looping fashion. Jixxa remembers the last
song

it played, so that whenever you turn on the music option (or start up Jixxa) it will start
with the next song, so that you don't have to listen to the same all of the time.

Save Box Locations. This option determines where existing boxes appear when they
are shown (made visible). If this option is checked, boxes are shown in their previous
location. Otherwise boxes are shown at the default location. Note that after scrolling
the screen with this option checked, a box can be shown but may not be visible
because it is scrolled out of view. This option applies to the floating picture as well.

Scroll to Origin. This option centers the display.

Nail/Unnail. This option allows you to nail a piece to the screen. When a piece is
nailed down, it cannot be grabbed or dragged. This feature is useful when large parts
of the puzzle are assembled and you don't want to accidentally drag them. When this
option is selected, the cursor will change to a hammer. Click on any piece that is not in
a box to nail it to the screen. If the cursor passes over a piece that is already nailed
down, the hammer will change to the claw to indicate that you can release the piece.
This mode ends when a piece is selected. Press Escape to cancel the nail down mode.

Unnail All. This option releases all pieces that are nailed down.

Show Timer. This option is available only in the registered version of Jixxa. This
option toggles display of the timer. The timer is always running when a puzzle is open.
Select this option to make the timer visible.

Pause. This option is available only in the registered version of Jixxa. This option
pauses the timer. A dialog box will prompt to you restart the timer when you are ready.

Hint. This option is available only in the registered version of Jixxa. The Hint allows
you to find a match for a piece. When this option is selected, the cursor will change to
a question mark. Click the left mouse button on any piece and Jixxa will find a match,
drag the pieces together and lock them. Hint mode ends when a piece is selected. Press
Escape to cancel hint mode. Note that you cannot get a hint for a piece that is
completely surrounded.

Auto Solve. This option begins auto solve mode. Jixxa will automatically assemble
the puzzle for you. When auto solve mode is entered, a small control appears at the
upper right corner of the screen. This control allows you to adjust the speed or stop
auto solve. Note that functionality is limited during auto solve mode.



Difficulty Menu

Lock Non-Matching Pieces. This option is available only in the registered version of
Jixxa. This option permits the locking of any two pieces as long as their sides match.
Watch out because there can be many wrong combinations. Use the Control right
mouse button combination to unlock a piece and drag it away.

Rotating Pieces. This option is available only in the registered version of Jixxa. By
default, all pieces appear right side up. This option will randomly orient pieces in one
of four directions. To rotate a piece, grab it and, while holding the left mouse button,
press the space bar. Each time the space bar is pressed, the piece will turn 90 degrees
clockwise.

Boxes Menu

Create Box. Select this option to create a new box. Up to 9 boxes can be created. You
will be prompted to name your box.

Destroy Box. Select this option to destroy a box. You will be prompted to select a box
from the list of all boxes. Note that there will always be at least one box. When a box
is destroyed, its contents are dumped on the screen.

Rename Box. Select this option to change the title of a box. If more than one box
exists, you will be prompted to select the box.

Show All. Select this option to show all boxes.
Hide All. Select this option to hide all boxes.

Destroy All Select this option to destroy all boxes. Note that there will always be at
least one box. When all boxes are destroyed, the first one remains.

Dump Box. Select this option to dump the contents of a box. If more than one box
exists, you will be prompted to select the box. Note that when a box is dumped, the
pieces are scattered randomly over the entire screen. In contrast, picking up and
dropping pieces scatters them in a closer proximity to the cursor.

Fill Box. This option picks up all single pieces and places them in a box. If more than
one box exists, you will be prompted to select the box.

Default Box. This option and the ones below it list the boxes that exist. Whenever a
new box is created, its name is appended to the Box menu. If a box is visible, there
will be a check mark on the menu next to it. Select a box to toggle it on or off. Note
that the Control key in combination with the box number can also be used to toggle a



box.



Picture Menu

Show Picture. This option toggles the display of the picture. The floating picture can
be resized and dragged around the screen.

Full Screen. This option shows a full screen view of the picture. Press any key or
mouse button to end this mode.



DEFINITION OF SHAREWARE

Shareware distribution gives users a chance to try software before buying it. If
you try a Shareware program and continue using it, you are expected to register.
Individual programs differ on details -- some request registration while others
require it, some specify a maximum trial period. With registration, you get
anything from the simple right to continue using the software to an updated program
with printed manual.

Copyright laws apply to both Shareware and commercial software, and the copyright
holder retains all rights, with a few specific exceptions as stated below. Shareware
authors are accomplished programmers, just like commercial authors, and the
programs are of comparable quality. (In both cases, there are good programs and
bad ones!) The main difference is in the method of distribution. The author
specifically grants the right to copy and distribute the software, either to all and
sundry or to a specific group. For example, some authors require written
permission before a commercial disk vendor may copy their Shareware.

Shareware is a distribution method, not a type of software. You should find software
that suits your needs and pocketbook, whether it's commercial or Shareware. The
Shareware system makes fitting your needs easier, because you can try before you
buy. And because the overhead is low, prices are low also. Shareware has the
ultimate money-back guarantee -- if you don't use the product, you don't pay for it.



JIXXA REGISTRATION INFORMATION

This "shareware version" of the Jixxa package is provided at no charge to the user for
evaluation. Feel free to share it with your friends, but please do not give it away
altered or as part of another system. The essence of "user-supported" software is to
provide personal computer users with quality software without high prices, and yet
to provide incentive for programmers to continue to develop new products. You are
encouraged to pass the sharware version of Jixxa along to your friends for
evaluation. Please encourage them to register their copy if they find that they can use
it. Please refer to the VENDINFO.DIZ file for details on distributing Jixxa. Please
do not distribute the registered (non-shareware) version if you order it -- continue to
distribute this shareware version.

If you find this package useful and find that you are using Jixxa and continue to
use Jixxa after a reasonable trial period (60 days maximum), you must make a
registration payment of $29.95 to Rhode Island Soft Systems, Inc. The registration
fee will license one copy for use on any one computer at any one time, and ensure
that you will receive a fully registered, enhanced version of Jixxa, which sports
several additional game features as well as a dozen new jigsaw puzzles! If you do not
have a copy of the Jixxa package, or are missing any of the files listed in the
VENDINFO.DIZ file, you may obtain a full registered version of Jixxa on CD-ROM
directly from Rhode Island Soft Systems, Inc. for the $29.95 (U.S.) registration
price, or download a shareware version from our internet web site, our BBS, or
CompuServe.

Please refer to the file REGISTER.WRI for a complete registration form.



BENEFITS OF REGISTRATION

What will registration yield? First and foremost, registered users are sent a disk
containing the registered version of the software, with the additional game features
and four new jigsaw puzzles. Besides rightfully paying for a product that is being
used, a user will additionally receive some very important benefits.

Upon receiving a registration, Rhode Island Soft Systems, Inc. will immediately
return a written receipt, a letter of acknowledgment thanking the user for
registering the software, literature on any special offers available at the time of
registration, and the latest issue of RISS News, our company newsletter!

The user is immediately placed in our database of registered users from which we
generate mailing lists for our newsletter which is used to announce upgrades to
our products, or new products altogether. This is very important since many users
have registered "old" versions of our software, not knowing that a newer version was
available. We were able to provide them with a new version which they might not
have received otherwise.

Registered users are provided with discounts on other products, as they are released,
as well as limited-time special offers that we are able to grant at the time of
registration. (In the past we've been able to grant major discounts on several
different magazines, free subscriptions to CompuServe, free CompuServe usage
credits, and more!)

Registered users are encouraged to take advantage of our Corporate BBS. Of
course, your registrations provide us with the capital necessary for us to continue
providing new versions of Jixxa as well as other new products, and additional add-on
puzzles.

While we courteously answer all letters we receive, registered users are provided
with the highest possible degree of customer support for their questions and concerns.



HOW TO CONTACT RHODE ISLAND SOFT SYSTEMS, INC.

At Rhode Island Soft Systems, Inc., we believe excellent customer service to be our
primary objective. We make ourselves available for customer support via several
methods. Please use the method that best suits you.

ORDERS
Toll Free: 1-800-959-RISS
(1-800-959-7477)
U.S. MAIL
Rhode Island Soft Systems, Inc.
PO Box 748

Woonsocket, RI 02895-0784
USA

QUESTIONS / SUPPORT

Voice: (401) 767-3106
Fax: (401) 767-3108

ON-LINE
CompuServe: GO RISS, Library/Section 5

Internet World Wide Web:  http://www.risoftsystems.com
BBS: (401) 767-3931



CONNECTIONS BBS

If you have an questions or comments you may contact Rhode Island Soft Systems,
Inc. on our 24-hour customer support BBS. CONNECTIONS BBS always
contains the latest version of Jixxa, which can be downloaded even by un-
registered, first time callers. We hope to hear from you on CONNECTIONS!

CONNECTIONS BBS Supports up to 14.4 kbps with V.32 / V.32bis / V.42 / MNP
optional. Use No parity, 8 data bits, 1 stop bit (commonly referred to as N,8,1).
The phone number is (401) 767-3931.

COMPUSERVE

As an alternative to CONNECTIONS BBS, customers are encouraged to join us on-
line on CompuServe where Rhode Island Soft Systems, Inc. maintains a presence.
Just type GO RISS -- we're in Section/Library 5! Shareware versions and demos of
our products can be downloaded there, and the support and development staff can be
contacted there with questions.

INTERNET

If you have access to the "World Wide Web" on the internet, please visit our site to
learn more about our company and our products and services. Shareware versions of
our products are available for downloading! http://www.risoftsystems.com

We look forward to seeing you on-line!
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Jixxa is produced by a member of the Association of Shareware Professionals
(ASP). The ASP wants to make sure that the shareware principle works for you. If you
are unable to resolve a shareware-related problem with an ASP member by contacting
the member directly, the ASP may be able to help. The ASP Ombudsman can help you
resolve a dispute or problem with an ASP member, but does not provide technical
support for members' products.

Please write to the ASP Ombudsman at:
ASP Ombudsman
545 Grover Road

Muskegon, M1 49442-9427
U.S.A.

or send a CompuServe message via CompuServe MAIL to:

ASP Ombudsman - 70007,3536.



JIXXA WARRANTY INFORMATION

*** PLEASE READ THIS INFORMATION CAREFULLY *#*%*

TRIAL USE (SHAREWARE EVALUATION VERSION) WARRANTY:

The Shareware evaluation (trial use) version is provided AS IS. Rhode Island Soft
Systems MAKES NO WARRANTY OF ANY KIND, EXPRESSED OR IMPLIED,
INCLUDING WITHOUT LIMITATION, ANY WARRANTIES OF
MERCHANTABILITY AND/OR FITNESS FOR A PARTICULAR PURPOSE.



TRADEMARK DECLARATIONS

Jixxa(tm) and all Rhode Island Soft Systems, Inc. products are
trademarks or registered trademarks of Rhode Island
Soft Systems, Inc.

Other brand and product names are trademarks or registered
trademarks of their respective holders. Windows, as
used in this documentation, shall refer to Microsoft's
implementation of a windows system.

COPYRIGHT STATEMENT

This software and accompanying documentation are protected by United States
Copyright Law and also by International Treaty Provisions. Any use of this
software in violation of Copyright Law or the terms of the Jixxa limited license
will be prosecuted to the best of our ability.



